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Editor’s
desk

A Letter to the desk of the Editor" to "Letter from Editor's
Desk
Hello readers, I hope our April edition helps you a lot in achieving your desired answers and
solving your little problems to work with SketchUp. Every time with every edition SketchUp-UrSpace team try our best to preset some new and exciting SketchUp related things to you.
Readers are our big assets who inspire us to find some new ideas and discussions on SketchUpUr-Space magazine. On our every edition we try to present some new things for our readers
who are SketchUp professionals; but beginners sometimes face some problems in using
professional tips so in this edition we have added some old extensions also. This edition is a
mixture of different plug-ins, tutorials, experience from our SketchUp teachers and
professionals. Without fussier talking lets hit the floor for some new ideas on SketchUp news,
tricks, tips and articles.
In every single edition, being a SketchUp lover and admirer we try to focus on the things that
will help readers in creating their 3D models. 3D models are the best way to share ideas, view
future ideas and connect with other people all over the world. SketchUp is the best way of
creating 3D models and using them for getting some better results.
Our Magazine, SketchUp-Ur-Space never delays to deliver the latest news, tips and many more
unique things about SketchUp for our valuable readers and our December edition is full of
them. It has some trendy and exciting news for our eagerly waiting readers.
SketchUp-Ur-Space is a well known and lovable magazine that consists with some useful news
and data for the beginner and experienced SketchUp users, designers, architects etc. Our
magazine’s editorial team always wants to give our readers new and interesting stories, news,
blogs and many more other things to enhance the knowledge and skills. This January edition
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has come up with the same motto and various unknown surprising facts on 3D designing that
will surely amaze you.
The cover story of this edition is the review of a special SketchUp guide book named “The
Definite Guide to Getting Started” written by Alex Oilver. This book is a must read book for both
SketchUp newbies and professionals as it is easy to understand and divided by the sections for
professionals and beginners. The step-by-step processes will definitely help a newbie to
become professional.
In the Article section there are 4 relevant topics written by our editorial team that depicts
about using some new SketchUp tools and extension which help to smoothen the modeling
process. The first article is about Using Images for Scaling and Geometry patterns in Sketchup
where a new class ruby is added in SketchUp 2018; second one is a review of new plug-in
named Adobe Dimension 2.0.; third one is some tips given by Classical Architecture Modelers
and the last one is about Christina Eneroth’s extension ecosystem.
The Blog section includes two reviews and two drawings in SketchUp, such as: 1) Drawing Basics
and Concepts of SketchUp, 2) Review of Eneroth Tool Memory; 3) Review of British Institute of
Interior Design Accreditation and 4) the way of making a Candle holder.
The Tips and Tricks section will help new beginners to be easy with SketchUp through some
easy learning process of 1) CleanUp3 and Solid Inspector2 tools; 2) creating Own SketchUp
Material Libraries; 3) Importing SketchUp textures and Creating Custom materials and 4)
Custom Toolbar Button Images in Layout.
Meanwhile the news section comes with some fresh contents like 1) Free Textures Pack of 2018
Christmas; 2) about the Whimsical furniture; 3) modeling a Face Me Christmas Tree and 4)
Vertex Tools Extension.

Hope readers will enjoy this edition and discover some new side of 3D design.
Source: https://www.dropbox.com/s/bwb0zw262ow9l59

If you have any queries concerning publication, subscription, troubles navigating the site, please
mail us at mailto:subhra@jobs2india.com
Best Wishes
Editor
Subhra Bera
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Articles

USING IMAGES FOR SCALING AND GEOMETRY PATTERNS
IN SKETCHUP
SketchUp 2018 has added a new class in ruby, the ImageRep which goes further and allows the
users to look at the images on a pixel by pixel basis.
The new version of SketchUp, SketchUp 2018 has included a new class in ruby which is called
the ImageRep. It is like the opposite of the regular Image class which users use to work while
working with images as entities in SketchUp; this ImageRep class goes further and allows the
users to look at the images on a pixel by pixel basis.
Overall, ImageRep is a referenced image representati on object.

Instance Method Summary:













#bits_per_pixel: this method gets the number of bits per pixel in the image.
#color_at_uv: this method returns a color corresponding to the UV texture coordinates.
#colors: this method returns an array of Color for each pixel in the image.
#data: this method gets the pixel data for an image in a string of bytes.
#height: this method returns the height of an image.
#initialize: this method creates a new image object.
#load-file: this method loads images data from the specified file.
#row_padding: this method returns the size of the row padding of an image in bytes.
#save_file: this method saves an image data object to an image file specified by a path.
#set_data: this method sets the pixel data of the ImageRep.
#size: this method gets the total size of the image data in bytes.
#width: this method returns the width of an image.
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The model is done by Alexander Schreyer; he is a Senior Lecturer and Director of the Building
and Construction Technology program at the University of Massachusetts. He is also the author
of “Architectural Design with SketchUp” and of various SketchUp plugins, including the
Sketchpad uploaded. Alexander has created a code snippet also to make understand the users
about the making of the 3D model and he also created a demonstrative video link is:
https://bit.ly/2B1MH
ZM; this code is
reasonably
straightforward once
one figures out the
basic
geometry
behavior.
The
code
also
stretches the image
by the dimensions of
the
selected
geometry; the code
applies the image
data as a scaling in 2
to objects; so users
can rather move
things round then
need to replace that
with a translation.
The
line
below
demonstrates about
the look; he made two changes in this new version; one is that he is inverting the effect simply
by including (1- scale) and the other is that he didn’t want fraction values for the scale but
rather only zeroes and ones. This is made by rounding the scale with .round.
Though the color information in an image is needed to resolve that contained red, green and
blue data, as it is not very useful here, since a single scaling factor is needed. So he added a
small routine to convert those to grayscale at values from white to black.
Almost everything can designed in 3D with SketchUp and who have splattered in 3D drawing or
are interested to learn the basics of design, SketchUp for Dummies has made it faster and
easier to learn the ropes of a powerful, user-friendly tool that bring life into the design ideas.
Users can get guidance here from creating a basic 3D model to showcase their work through 3D
print or animation, literally everything in SketchUp that can help in anywhere like from
redesigning the house to mocking up the future great invention. More than that, SketchUp’s
vast usability has gotten very wide success as a tool that even non-designers can also make
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basic drawings; there are also many expert tips from former SketchUp product director Aidan
Chopra and co-author Rebecca Huehls that help to draw and access SketchUp
.
So, this is basically what the SketchUp users need to be able to read pixel color values and then
use those to create or modify geometry.

Source: www.sketchupfordesign.com/tutorials/scripting/

ADOBE DIMENSION 2.0 IS 3D FOR GRAPHIC DESIGNERS
Trimble Navigation is very excited to join with Adobe in announcing that native SketchUp
interoperability has been added to Adobe Dimension 2.0.
Trimble Navigation is so excited and happy to share their announcement with everyone about
their new ways of working with Adobe with using it. Here are some information about Adobe
Max and Adobe Dimension 2.0.
Adobe Max: With Adobe everything is about the design process and their designs are being
published at their annual creative conference called Adobe MAX. This year they have made it
more impressive as the software giant is currently at its most improved with a focus on virtual
reality, artificial intelligence and accommodating new programs to encourage the current
generation of creative people. This huge seminar includes about 12000 creatives including
influencers, guests, designers and developers from all over the world, for what was the biggest
output the conference has ever seen. It was a grand opportunity to explore ideas, learn from
experienced persons and influencers; besides that it became a new discussion platform to start
a new era of art and technology for starting something fresh and new.
Adobe Dimension 2.0.: This New Year has been a wild ride like aggressively expel new features
and abilities, engaging with Adobe’s user base and hearing peoples’ stories of exploring the new
Dimension and upgrading new partnerships for Adobe across the wider 3D ecosystem. All of
this has been included in this year’s Adobe MAX where they are launching the biggest update of
Dimension so far which is Dimension v2.0 in front of the world’s creators, storytellers and our
best friends.
Adobe Dimension v1.0 had come in the market a year before and it showed the world a new
type of creative space, it is the one that brought the macrocosms of 2D graphic design and 3D
modeling together into one simple tool. Dimension became an important tool for traditional
Illustrator and Photoshop users as it gave a spatial context to classic graphic design work such
as product packaging, product photo shoots and apparel design. For architects and interior
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designs, Adobe Dimension offered a new method to work with presentation renderings while
for artists it helped them by blurring the line between 2D and 3D.
After releasing of the new version Dimension v2.0 the whole Adobe become very busy; they
have improved the interoperability between Dimension and the rest of Adobe’s Creative Cloud
applications. Now this new release can natively reads SketchUp models with 100% fidelity so all
the designs will now become more lively and beautiful than ever. 3D working will add more
vibrant in the designs in every field, users now can create more new and creative designs for
their clients and customers. People who are already subscriber of Adobe Creative Cloud can
have the full release of Dimension to use and can also share their Dimension projects on the
SketchUp 3D Warehouse with the #dimension for further share and use.
Source: www.blog.sketchup.com/article
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CLASSICAL ARCHITECTURAL MODELERS TALKED ABOUT
NINE WORKFLOW TIPS

Classical Architectural modelers of Holygon have been working on 3D models since a long time
and they apply some kind of tips for perfect models.
Holygon is a Swedish Company that specializes in making historically-precise digital models for
visual and 3D printing applications. At 3D Basecamp 2018, Founders Andres Lyhagen and Felix
Heuman have presented how to accurately model urban spaces for 3D printing; they also
shared their top workflow tips with the whole SketchUp community.
It combines deep knowledge of traditional design principles with command of recent digital
technology to create state-of-art digital and physical 3D models of cities, architecture and other
bespoke forms. They specialized in accuracy-modeling large urban cityscapes and individual
buildings ready for true-to-life full-color 3D printing. Besides, they also program custom 3D
tools, teach the art of 3D and visualize 3D models.
3D Basecamp 2018: 3D Basecamp is a much awaited place for all types of Sketch Uppers where
they meet to teach, learn and inspire each other and this time 3D basecamp is going to held in
Palm Springs at California from September 24th to 28th 2018. It is the program of a full week
which most probably will be the best week for all the SketchUp lovers as they can develop their
3D modeling skills, increase the social circle by connecting with more people and can view the
beauty of California.
The first two days will only be focused on SketchUp Bootcamp training track where the
bootcamp meetings will be hands-on workshops that are exact for learning SketchUp or just
simple upgrading the industrial workflows. After that there will be a 3 day conference which is
the most popular 3D basecamp ticket which includes the main Basecamp conference track with
a set of bootcamp training workshops for both novice and medium SketchUp users. The total 5
days conference and training both can be attained by the specified ticket. By signing up for the
3D basecamp Conference and Essential Training ticket, SketchUppers can get the chance to take
SketchUp 102 and 201 courses, a basic training for architectural design, design/build and

10 | P a g e

interior design. Besides that, there is an important agenda of presentations like details and
estimates, drones and scanning, VR and Visualization, 3D printing and CNC, concept art and
prop making, low-poly and many more.
Here are workflow tips to follow while modeling in SketchUp:
o Control the expression: Their initial drafts are fully hand-drawn as they follow
traditional principles and use traditional elements like pedestals, columns, entablature

etc.
o Quality references: They always search the highest quality measured drawings of a
certain order; with quality they never take a risk.
o Know your form: Seeing a thing in a way matters while working on it.
o Know the tools: SketchUp has always multiple solutions for every challenge, like there
are lots of tools to work. Before working on any design, it is important to know the exact
tools to use as it will add perfection.
o Draw contours: Drawing in 2D may take longer than finishing 3D volumes but using
shortcuts will help to make the exact layers.
o Solid: modeling in all solids needs discipline and solid modeling principle is a fierce
teacher but also a better option.
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o Components: It helps both performance and model management as it applies at
multiple abstraction levels.
o Combining independent parts: Always make separate parts of a design and then
combine them it will give the sharp edged model.
o Finalizing model: They finalize models after completing all other parts.
Source: www.blog.sketchup.com/article

AN EXTENSION ECOSYSTEM WITH CHRISTINA ENEROTH

SketchUp is a most loved extension all over the world with lot of extensions of work on 3D
models; Christina Eneroth has added some new extensions which are lacking in it.
The SketchUp extension is full of wonderful tools or commands that make the 3D modeling in
SketchUp much easier; users can download all these tools or extensions and upload their
models in the warehouse for others. It is an online resource with various plug-ins developed
made especially for SketchUp and these extensions help to add some special tools and features
to SketchUp. These extensions can be found for any particular application like drawing or 3D
printing and some industry specified tools for architecture, interior design, construction and
many more.
But there are some tools which are still not found in SketchUp Extension there Julia Christina
Eneroth starts here work. She builds those tools or commands for users and she has been doing
it since a long time. She is a designer and developer in SketchUp and till now has published
about 66 extensions and plugins to Extension Warehouse; she also has created virtually her
very own 3D modeling ecosystem.
First experience with SketchUp: Julia Christina Eneroth was first introduced to SketchUp while
working on shadowing an architect in elementary school; she downloaded the free version and
worked at home. In those earlier days, SketchUp download took a very long time and 3D
Warehouse had a 10 MB file size limit so there wasn’t much space to publish models.
First extensions in SketchUp: Her first script was for assigning layers to geometry called Schools
Eneburg, a castle with many levels with different ceiling heights and floors. It became
impossible to look inside the model with SketchUp’s native section cut tool so she thought to
write her first ever SketchUp Ruby script. But as the quality of the code was not that strong so
she abandoned some projects, made some small changes and there she learned about code
readability, decoupling and organization the hard way. According to here, while developing an

12 | P a g e

extension anyone must think about its intended scope; as adding an extra feature in extension
is easy but adding it without a scope will make it messy.
The Castle Project: Julia is always been fascinated by castles and once she started a high school
project on castle which took a long time, her lots of hard work and skills on SketchUp. Though it
was a single project, but actually it was a combination of all her previous works and made her
learn about SketchUp.
Her new ideas about new extensions: All of her new extensions are created as her own need of
modeling workflow and these extensions at first start as a few lines of code or a single line
which she writes in the Ruby console to make it easier. After that, she builds a proper UI,
designs the icons, writes documentation and creates images to describe it.

Julia’s five favorite extensions:
1. Swift Layer Visibility Control: It makes layer visibility control more flowing; she created
it as a shortcut for hiding the selected layers. Another shortcut shows all layers and
another one re-hides all layers that were last shown and created by Eneroth herself.
2. Selection Toys: It is made by Thom Thom and a must-have product that allows users to
select existence by a certain criteria often based on the previous selected to make
modeling more efficient.
3. Tool Memory: Designed by Eneroth, it helps to swap back and forth between tools
without having to move fingers to the different shortcuts.
4. Solid Tools
5. Solid Inspector
Native extensions to SketchUp: Though according to her, very few extensions are native to
SktechUp, but Weld should be a native command.
Source: www.blog.sketchup.com/article/under-hood-extension-ecosystem-christina-eneroth
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News

FREE TEXTURES PACK CHRISTMAS 2018

SketchUp textures are created by SketchUp professionals for making the 3D models better and
lively; in the Christmas of 2018 SketchUp Texture Club has published 9 different textures.
SketchUp Texture Club is an educational and instructive portal, directed to the 3D community
with particular emphasis on visualization and rendering proficiencies addressed to students and
to the professionists of architecture and interior design and all for those who are impending the
learning of the 3D visualization. The web site of SketchUp texture known as SketchUp Texture
Club the professionals generally share about the experience and the work material helpful to
the increasing of the use of the 3D world; besides that, their portal unites CG fans and
Professionals alike and their success has made them one of the most important CG resource
sites in the world. They at first born as a Facebook community and was founded in September
2010 to share and compare with all the 3D graphics enthusiasts, materials, information,
impressions, news and trends in architecture and interior design that has become in a short
time an important point of mention for all those people working in computer graphics and 3D
modeling.
In the Christmas 2018, the professionals of SketchUp texture Club, they published a gift pack
containing 9 different fantastic professional textures which are consistently high in resolution
and came with complete maps which are removal, normal, specular and ambient closure.

Here is a little description of the package of textures:
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o 3 different wooden floors textures in high resolution: they come with complete maps
package which are removal, normal, specular and ambient closure. Pixels are 3598 ˣ
2563, 3598 ˣ 2881, 3632 ˣ 3565.
o 3 different Marble wall cladding textures seamless high resolution: they come with
complete maps package which are removal, normal, specular and ambient closure.
Pixels are 3000 ˣ 3000, 3000 ˣ 3000, 3000 ˣ 3000.
o 3 different Wall plaster textures seamless high resolution: they come with complete
maps package which are removal, normal, specular and ambient closure. Pixels are 3072
ˣ 3072, 3072 ˣ 3072, 3072 ˣ 3072.

SketchUp or Google SketchUp is mainly a 3D modeling computer program that is used for a
broad range of drawing applications used by architects, interior designer, landscape architects,
civil and mechanical engineers, film and video game designers also. SketchUp can be getting as
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a freeware version named SketchUp Make and a paid version with many more extra benefits
called SketchUp Pro. SketchUp is software from Trimble Company and there is an online library
of free model congregations and 3D Warehouse to which users can add other models; besides
that, the program has drawing layout functionality with variable ‘styles’, supports third-party
‘plug-in’ programs hosted on the Extension Warehouse to supply other abilities and enables
placement of its models in Google Earth. As SketchUp users are most of architects, designers,
builders, makers and engineers etc. who works hard to give a nice shape to our physical world,
they need great tools to do the work.
SketchUp is in mission to bring their best to produce some great tools for drawing as drawing is
the key thing of the SketchUp users. They draw to search ideas, to identify the things and to
show other people their work that they do with love and love to build; SketchUp understands it
truly and trying to improve their software day by day.
Source: www.sketchuptexture.com/2018/12

REVIEW OF THE WHIMSICAL FURNITURE

Annie Bossert, a fiber artist and woodworker who creates functional and playful pieces that
bring levity to everyone’s experience by mixing her talents in woodworking and fiber arts.
Annie Bossert is a mixed media artist who is specialized in custom furniture design; she grew
up on a farm in central Illinois where her love for stripes also born as she lived with rows of
rows of corn and soybeans. She started her career as a furniture maker where she used
plywood to express her interest in stripes by cutting different angles into the plywood to make
different striping effects. Anne indirectly got into woodworking through working with textiles;
she loved to mix different ways to combine her textiles and woodworking while working in her
shop in Fort Collins, CO.
Recently Anne is designing and building all of the studio furniture pictured on her website; she
is a fiber artist and a woodworker mixed up into one person. Her designs are original but she is
quite inspired by mid-twentieth century furniture and industrial design.
This article is a little description about Anne’s recent work “The Whimsical Furniture” and some
details about her life, work and inspiration etc.

Little about the start of Anne’s interest in designing:
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In her words, her mom inspired her to be interested in strips from her childhood when her
mom gave her some clothes and told her to sew them. It was her first introduction to the world
of textiles as well as the concept of making hr won designs. This mindset led her to join a
furniture making class where she made her first work, storage for CDs than a plastic milk crate.
Besides taking classes on woodworking, she also developed her knitting and weaving skills to
make more designs on wood. After a few years, she joined in a job in a sign shop where she had
to fabricate signs that helped to better understandings of tools and making.

Little about her furniture design:
She is a fond of functional art and loves to assemble all the careful curation of the objects with
surrounded objects to make them more interesting and beautiful. She always tries to challenge
people’s expectations about the look of furniture with their mood; in her works, she mess with
their perceptions on views and then she dyes and weaves stripes into the textiles that are the
same width as the stripes of the laminations in her used plywood. When the striped fabric is
mixed into a piece of striped plywood and both dyed in the same color than the mind blowing
furniture comes out.
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Her ways to communicate design intent to customers:
Anne does a lot of commissioned pieces so she has to ensure that her customers have a solid
understanding of what they will be getting. Whenever she makes something which is hand dyed
or hand woven fabric, she makes a custom material in SketchUp; she at first simply scan a
sample of her fabric and paint into her SketchUp model for maximum realism. According to her,
SketchUp helps her to make simple designs wonderful through easy used tools.

More about her design process:
She follows a new design process that she has developed in the last couple of years; it is an
exciting process where she at first cut an angle into plywood and saw all the hideous different
stripes inside the materials, then she saved the offcuts and scrapes from projects. But now she
likes to begin with a composition of offcuts as doors or drawer fronts and then design a piece of
furniture to work more over it. So she will lay out the offcut assemblage, then measure it,
photograph it, then put it into SketchUp, size the image to scale and then sketch the furniture
design to work more.
Source: www.blog.sketchup.com/article

ce:www.blog.sketchup.com/article/sketchup
MODELING A FACE ME

CHRISTMAS TREE IN SKETCHUP

Importing an image from another file in SketchUp is an easy process but transferring a normal
image into a Face Me component is a little complex task that is shown in here.

About SketchUp:
SketchUp or Google SketchUp is mainly a3D modeling computer program that is used for a
broad range of drawing applications used by architects, interior designer, landscape architects,
civil and mechanical engineers, film and video game designers also. SketchUp can be getting as
a freeware version named SketchUp Make and a paid version with many more extra benefits
called SketchUp Pro. SketchUp is software from Trimble Company and there is an online library
of free model congregations and 3D Warehouse to which users can add other models; besides
that, the program has drawing layout functionality with variable ‘styles’, supports third-party
‘plug-in’ programs hosted on the Extension Warehouse to supply other abilities and enables
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placement of its models in Google Earth. As SketchUp users are most of architects, designers,
builders, makers and engineers etc.
who works hard to give a nice shape to our physical world, they need great tools to do the
work. SketchUp is in mission to bring their best to produce some great tools for drawing as
drawing is the key thing of the SketchUp users. They draw to search ideas, to identify the things
and to show other people their work that they do with love and love to build; SketchUp
understands it truly and trying to improve their software day by day.
This article is about the method of learning to create a 2D Face Me component that always
faces the camera in SKetchUp. From the previous videos about 2D Face Me it is known that
using 3D vegetations in SketchUp could make good results but it also slow down the rendering
procedure and overall workflow quite a bit.
Justin Geis is the founder of The SketchUp Essentials and started using SketchUp while he was
working as a general contractor in 2008 and after using it he found that SketchUp is extremely
powerful that he just started to use it in his personal works also. Then he started The SketchUp
Essentials as a place where he could share his ideas of using SketchUp easily through some
tutorials and tips to help other users controlling the power of 3D Modeling in everyday lives.

About Extension Warehouse:
It is an online resource with various plug-ins developed made especially for SketchUp and these
extensions help to add some special tools and features to SketchUp. These extensions can be
found for any particular application like drawing or 3D printing and some industry specified
tools for architecture, interior design, construction and many more. So basically in this
Extension Warehouse people can do the following things:
o Users can search extensions by name or as per the functionality.
o They can also install various extensions with a single click of a button.
o Or users can also control all the extensions from easy-to-use location in the My
Extension page.
At first, Justin downloaded the image of a Christmas tree from Google with a transparent
background and then imported it in SketchUp; while importing an image, users should click on
the image option. After importing the image will appear as flat image which will not allow users
to work on it. Next Justin trimmed the sides as per size of the image using the Move tool and
transfer the whole image in a group. Then he started to turn this image into a component by
following steps:
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o Right click on the image and select the option “Make Component”, which will open a
pop-up window.
o To turn this component as a Face Me Component click on the Option called “Always
Face Camera” from the pop-up window.
o At last click on Create button and it will appear as a component that always faces
Camera no matter in which angle it is rotated.
After that this image is ready to work as a texture or component in any project; users can make
copies of the image or can use it in creating new designs etc. but they will always face to the
camera.
Source: www.thesketchupessentials.com
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About Extension Warehouse:
It is an online resource with various plug-ins developed made especially for SketchUp and these
extensions help to add some special tools and features to SketchUp. These extensions can be
found for any particular application like drawing or 3D printing and some industry specified
tools for architecture, interior design, construction and many more. So basically in this
Extension Warehouse people can do the following things:
o Users can search extensions by name or as per the functionality.
o They can also install various extensions with a single click of a button.
o Or users can also control all the extensions from easy-to-use location in the My
Extension page

About Thom Thom:
Thomas Tomassen is actually known as Thom Thom, he is a modelmaker with a large desire for
physical, digital and traditional design in most kinds of the trade. He is also focused on
webdesign or programming and 3D visualizations but he is specialist in 3D modeling, SketchUp,
Webdesign, graphic design and web programming.

Vertex Tools
This extension can take control over each vertex editor for SketchUp; its soft sections are a
must needed thing for organic modeling and the manipulator gizmo will allow users to take
great control while modeling. On the Vertex tolls website, users will find a list of all features
along with a comprehensive manual and videos. This vertex tools can be tried for 30 days with
proper registration where after the trail period, users have to buy a license to continue the use
of it by paying $20.
But recently Thom Thom has updated the Vertex Tools and made a fully functional Trial version
that anyone can test for 30 days. But if anyone get hooked and is a Premium Member at
SketchUcation, will be enough to get lucky to have a 20% discount in the SketchUcation shop.
The Trial Version of Vertex Tools is now can be found form the SketchUcation Plugin Store or
the Extension Warehouse.
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Features
o Manipulator Gizmo: The Gizmo allows for quick operations without exchanging out of
selection mode and all the actions can be adjusted by the VCB for final precision
adjustments.
o Extrude Edges: Gizmo is used to quickly extrude edges from any selected geometry
which can even takes into account the soft-selection.
o Soft-selection: It is set by taping in a length in the VCB while a selection toll is active. It
vertices within this distance from the selected vertices are affected by tools that modify
geometry.
o Auto-Smooth: When a face is deformed in a way that the vertices are not coplanar,
SketchUp Autofolds the face by adding new edges which are normally not soft but
create a faceted surface. After enabling Auto-Smooth, these new edges will be softened
and smoothened to give a continuous surface.
o Lock UV Mapping: Vertex Tools preserve users UV mapping those will distort by
SketchUp then it will manipulate the model’s geometry and the UV mapping is pinned to
each vertex to keep continuity.

Menus & Toolbars:
o Tools >> Vertex tools
o Context Menu >> Vertex Tools
o Toolbars >> Vertex Tools

Menus & Toolbars:
o SketchUp 6* or never
o Windows XP or newer version (internet explorer 7 or newer)
o OSX 10.4 or newer in Intel or PPC
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Tips
& Tricks
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USING SKETCHUP’S CLEANUP3 AND SOLID INSPETCOR2
TOOLS
SketchUp’s Extension Warehouse is full of useful and faster working tools or extensions which
will make the 3D printing and working on it better than before.
3D printing or additive manufacturing is way of making three dimensional solid objects from a
digital life. The creation or making of a 3D printed object is achieved using additive processes
and in this process, an object is made by laying down successive layers of material till the object
is created. Each of these layers can be visible as a thinly sliced horizontal cross-section of the
eventual object. So basically 3D printing is the opposite of subtractive manufacturing which is
cutting out a piece of metal or plastic with for specimen a milling machine.
SketchUp is just made for 3D printing and designing in SketchUp is cool as 3D printing is
something that moves is cooler and unique than that. In this article we are going to discuss
about a few features that can be include by the users to make their creations more than just
interestingly shaped hunks of immobile plastic. Aidan Chopra and Rebecca Huehls this time
comes up with new tricks about 3D printing in SketchUp.
Aidan Chopra was a beloved member of the SketchUp team for 10 years; he is the creator of
SketchUp Blog where SketchUp members and professionals share their new designs and tells
some tips and tricks to design various designs that help users a lot. This Blog has attracted huge
number of people and helps them to know more about SketchUp tools and extensions,
moreover that users can now easily use SketchUp in their everyday life. Aidan also taught
countless classes on SketchUp, he authored the SketchUp for Dummies Book.
Two tools from the SktchUp Extension Warehouse are important for every 3D printing work and
they are: CleanUp3 and Solid Inspector2; both of these are created by Thomas Thomassen.
Here is a little information about both of them:
o CleanUp3: This extension checks and simplifies the geometry of every SketchUp model
and combines multiple faces, deletes extraneous data any lines that don’t create a face.
There are also two most useful CleanUp3 options in the Warehouse such as Erase
Duplicate Faces and Repair Split Edges which can be enabled in the CleanUp3 menu.
These two options are errors that surely appear in the model while working in SketchUp
and they drive 3D printers nuts; moreover that these two are hard to identify and repair
manually. This extension also simplify STL or 3D-printable files that are imported into
many triangles and by removing that triangulation, CleanUp3 makes files downloaded
from 3D printing communities easily edited in SketchUp.
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o Solid Inspector2: This extension finds and highlights problems that are stopping
SketchUp 3D models from being a solid shell and its usefulness cannot be exaggerated.
It also highlights problem areas and helps users automatically from one error to another
and does the repairs much faster. So it is must have tool in every SketchUp model.
While working with 3D modeling in SKetchUp, everyone should run CleanUp3 periodically and
run Soli Inspector2 before exporting from SketchUp to 3D print is also necessary as they both
will help to find errors that would cause the printing failure.
Source: www.dummies.com/programming/google-sketchup
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CREATING OWN SKETCHUP MATERIAL LIBRARIES

SketchUp Material Libraries contain a huge number of textures and materials; this Libraries can
be created by user following some easy steps.
3D printing or additive manufacturing is way of making three dimensional solid objects from a
digital life. The creation or making of a 3D printed object is achieved using additive processes
and in this process, an object is made by laying down successive layers of material till the object
is created. Each of these layers can be visible as a thinly sliced horizontal cross-section of the
eventual object. So basically 3D printing is the opposite of subtractive manufacturing which is
cutting out a piece of metal or plastic with for specimen a milling machine.
There are more than 5000 materials in the nXt Material Library from where any user can select
any material and place it on a SketchUp face to create a similar SketchUp material. In many
cases the SketchUp material is like an estimate of the full fractal material which will be created
when users render the model.

The way of downloading the nXt Libraries:
Here are the steps to download and install the latest libraries:

o Click on the Downloads Page.
o After that users have to enter their name and email address and proceed to the
download page.
o Next they need to select IRender nXt Libraries from the right of the first row of
downloads.

The download contains:
o New nXt Materials.
o Older AccuRender Materials converted to nXt format
o New nXt Plants and Trees
o Older AR4 Plant and Tree Library
o HDRi Skies for the second and additional tabs on the HDRi Setup dialog
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The IRender nXt Libraries of plans and materials are only available for the clients who purchase
IRender nXt. The Libraries have the things like:

o AR3 materials converted to nXT .ArMaterial file format.
o New .ArMaterial files created for nXt.
o AR3 Trees and Plants.
o New nXt Trees.
o Additional HDRi skies for use with IRender nXt.
o Among many materials of nXt Libarries SketchUp Materials Palette is one which is used
to create some different patterns and colors in SketchUp model. To open the SKetchUp
Materials Palette here are the steps to follow:
o Click the ‘Paint Bucket Tool’ in the toolbar or use Windows > Materials menu entry.
o This will launch the palette from the toolbar button.
o Now click the ‘Create Material’ icon which will open a separate window that will allow
the users to input some color values or to add textures and set opacity levels for the
material.
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o If users want to load their own texture in the Palette simply click the ‘Browse’ icon in the
texture section of the Create Material Palette which will launch the ‘Open File’ dialog
and then can navigate to the location of the texture image in the hard drive.
o After getting the texture just click open to load it into SketchUp’s ‘Create Material
Palette’. Then users can give a name and dimensions to the texture and click ‘OK’ to
create the new material.
o To locate texture in SketchUp, users can pick ‘In Model’ option from the dropdown list;
this option will display all the textures currently in the model.
o Then save this new created texture into a new library Right click it and choose ‘Save As’
from the context menu.
o .skm is the default file type in it; to save materials to already existing libraries click the
‘Display secondary selection pane’ button.

Source: www.sketchucation.com/resources/tutorials

IMPORTING SKETCHUP TEXTURES & CREATING CUSTOM
MATERIALS

SketchUp Texture libarery is full of different textures that need to use in the SketchUp models;
but there are some textures not available, users can create their own and make Custom
Materials.
About SketchUp: SketchUp or Google SketchUp is mainly a 3D modeling computer program
that is used for a broad range of drawing applications used by architects, interior designer,
landscape architects, civil and mechanical engineers, film and video game designers also.
SketchUp can be getting as a freeware version named SketchUp Make and a paid version with
many more extra benefits called SketchUp Pro. SketchUp is software from Trimble Company
and there is an online library of free model congregations and 3D Warehouse to which users
can add other models; besides that, the program has drawing layout functionality with variable
‘styles’, supports third-party ‘plug-in’ programs hosted on the Extension Warehouse to supply
other abilities and enables placement of its models in Google Earth.
As SketchUp users are most of architects, designers, builders, makers and engineers etc. who
works hard to give a nice shape to our physical world, they need great tools to do the work.
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SketchUp is in mission to bring their best to produce some great tools for drawing as drawing is
the key thing of the SketchUp users. They draw to search ideas, to identify the things and to
show other people their work that they do with love and love to build; SketchUp understands it
truly and trying to improve their software day by day.
Though SketchUp has a quite nice order of materials built into it but it doesn’t have all the
materials that people want; this is a description of a tutorial that will help the users to learn
more about importing favorite SketchUp textures and turning them into new materials which
are used in the models.
Creating Custom Material Libraries in SketchUp is depended on understanding the nature of
materials within SketchUp; so the first thing the users need to know is about the original images
themselves which may be in the JPEG format or so on are not really SketchUp materials.
Originally they are the images that can load in order for creating these materials; the original
material file is a file that can be created within SketchUp that specifies about the material. For
creating this material file, users need to start off by making a custom material that can be
downloaded from many places like SketchUp Texture Club, CG Textures, and Textures.com etc.
The process will be started form clicking the plus button which is in the upper right hand corner
that will create a new material, if anyone wants to base it on a repeating texture image then
users can click on go down option and check the box for “use texture image,”; next users have
to find the related image to create a texture. Next the image has to resized and repositioned in
the model, after completing it the material will be created and need to rename it and save it in
the database.
Importing SketchUp textures and creating Custom Materials:
o

o
o
o

o

At first, users need to find a SketchUp texture to use; SketchUp texture is a great place
to find a huge number of free textures. While CGtextures extension is used as a
replacement of SketchUptexture extension earlier which are not all super clean but has
an awesome library to look through.
Then users have to click on Paint Bucket Tool that will show the Materials window popup. Or they can go to the Window tab and select Materials from the drop-down list.
Next click the Create Material button from the Material window.
After that the Create Material window will pop-up; it will help to import the SketchUp
textures. To import the textures users need to click the Import Image option in the
Texture Editor section, here the texture image will get uploaded and a preview of it will
be seen in the upper left hand corner. The Color Editor section is used to adjust the
material’s color without editing it in an external program and reimport it. Te Colorize
option is there in the Texture Editor section which will turns texture to black and white
and then puts the color overlay on top. The Texture Scale & Lock option in the Texture
Editor section will help to adjust the scale of the SketchUp texture. The Reset Color
option will help to put the colors from beginning if anything turns bad.
Next click Ok; after that the custom material will show up in the SketchUp material
library. Select it, take the Paint Bucket tool and paint it.
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Source: www.designerhacks.com/import-sketchup-textures

CUSTOM TOOLBAR BUTTON IMAGES IN LAYOUT
SketchUp users can get a nice new button icon in the toolbar and can add a Custom toolbar
button images in LayOut which is though an easy thing but need extra care to do it.
Matt Donley: Matt Donley has been working with SketchUp since 2007; at first he started
working as a carpenter and started using SketchUp to model things around his house. After that
he started to model his customer’s homes for helping them to visualize their construction
projects. He also wrote the “SketchUp to LayOut” book as a help for other construction
professionals as a learn how to make construction documents using SketchUp and LayOut. He
shares his SketchUp knowledge online with SketchUp users where he teaches how to create
tutorials and videos for helping people to learn how to work with 3D model online.
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In this article Matt has described about a new idea where he will show how to create own
custom buttons for any LayOut command as well as the way of creating a custom button image
for users to use the super-secret-hidden-built-in button image editor. Matt always has thought
that the default toolbar in LayOut should include a button to insert a SketchUp model into
LayOut file; though it is a common thing to do but it is a little weird to have to go to File > Insert
every time. Though, this option is a Windows-only option as it has a huge range of toolbar.

How to add Custom LayOut Commands:
o
o

o
o

It is a simple way to add new buttons to any LayOut toolbars and here are the steps to do:
At first users have to do Right-click in the toolbar area and then select the Customize option.

Next they need to select the Command tab in the Customize window.
Then users can find the commands that they want to add to their toolbar and then drag it
directly into the toolbar.
As all the commands don’t have icon images related to them, so there will appear an ugly text
button for these commands.
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Using the LayOut Button Image Editor:
It is not known o all that, when users have the customize window active, all of the toolbar
buttons become editable; then users can drag them to various positions and can pull them out
of the toolbar to remove them. Users can also click right button on them to get a contextmenu; this context-menu will give the users some magical capability to change the look of
button. Though the image can be downloaded from a pop-up appears in below the page; here
are the ways to add an image to the button:
In the Image Editor, users can use the drawing tools to create their own icon or can import an
icon that they have created in an external image editor. To import, click on File menu and go to
Open option. If users don’t want to go through the image editor window they can have the
image copied on the clipboard and can select Paste Button Image directly from the button
context menu.
Source: www.mastersketchup.com/custom-layout-button

Blogs

DRAWING BASICS AND CONCEPTS OF SKETCHUP

SketchUp users always find some easy ways to work in 3D modeling and drawing in SketchUp is
the most important thing that needs to be done through some easy concepts.
Drawing a model in 3D platform is bit different from drawing an image in 2D; in SketchUp users
have to draw on 3D platform with tools but this 3D drawing is not familiar to everyone so here
is a little introduction about all the drawing basics and concepts.
This article is a kind of description where people can learn about a few ways to create edges
and faces which are basic things of any SketchUp model.
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Drawing a line: The Line tool is used to draw edges from the structural foundation of all
models. At first the Line tool is selected and then the cursor changes into Pencil; next the click
on an area to draw a line. Then the cursor is clicked to set the line’s end point which can be also
the starting point of another line. Now Esc key is pressed after finished drawing lines and after
setting the end point, users should press Ctrl + Z (Microsoft Windows) or Command + Z (macOS)
to undo the line. If anyone wants to make the line a precise length he/she needs to type a value
and press Enter (Microsoft Windows) or Return (macOS); this process can be repeated until
drawing a next line.
Creating a face: When several lines are joined into a shape it will form a face which may be
plain but very important one; every face is the other half of the duo which enables SketchUp
model ever made to exist. Shape tools like Rectangle, Circle and Polygon create faces.
Dividing faces: When a line or a curve is drawn on an existing face, the face become split. It is
an important thing as after splitting a face, users can use the Push/Pull tool to push o pull one
part of the face while the other part stays put.
Opening 3D shapes by removing edges and faces: Users can erase an edge or face to make an
opening in a shape. To see how erasing an edge effects the model, users need to select the
Eraser tool at first in the toolbar or need to press the E key. Clicking an edge erases it and any
face that touched the edger; but context-clicking a face and choosing Erase will delete only the
face.
Healing deleted faces: If a face is deleted accidentally there are two ways to bring it back: 1) if
any other changes isn’t made by user and wants to keep the previous one, he needs to select
Edit > Undo from the menu bar or press the keyboard shortcut for Undo. 2) Users can redraw
the line that caused the faces to hide and SketchUp will re-create the faces.
Finding and locking an inference: SketchUp has an inference engine to help in working with 3D
space and this engine will help to find geometric relationship between lines.
Inference types: SketchUp has several types of inferences like point, linear and shape; SketchUp
often mixes them together to form a complex inference. Components and dynamic
components have their own inference types.
Locking inferences with a keyboard: It will help to draw along the direction according to the
user and it can maintain one drawing direction while users reference geometry from another
part of the model.
Ensuring edges are aligned to axes: It is helpful to change the cursor to the axes colors or if it is
need to check the alignment of existing geometry, the edges will be changed to the axes colors.
Source: www.help.sketchup.com/en/sketchup
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REVIEW OF ENEROTH TOOL MEMORY

About SketchUp: SketchUp or Google SketchUp is mainly a3D modeling computer program that
is used for a broad range of drawing applications used by architects, interior designer,
landscape architects, civil and mechanical engineers, film and video game designers also.
SketchUp can be getting as a freeware version named SketchUp Make and a paid version with
many more extra benefits called SketchUp Pro. SketchUp is software from Trimble Company
and there is an online library of free model congregations and 3D Warehouse to which users
can add other models; besides that, the program has drawing layout functionality with variable
‘styles’, supports third-party ‘plug-in’ programs hosted on the Extension Warehouse to supply
other abilities and enables placement of its models in Google Earth. As SketchUp users are most
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of architects, designers, builders, makers and engineers etc. who works hard to give a nice
shape to our physical world, they need great tools to do the work. SketchUp is in mission to
bring their best to produce some great tools for drawing as drawing is the key thing of the
SketchUp users. They draw to search ideas, to identify the things and to show other people
their work that they do with love and love to build; SketchUp understands it truly and trying to
improve their software day by day.

About Extension Warehouse:
It is an online resource with various plug-ins developed made especially for SketchUp and these
extensions help to add some special tools and features to SketchUp. These extensions can be
found for any particular application like drawing or 3D printing and some industry specified
tools for architecture, interior design, construction and many more. So basically in this
Extension Warehouse people can do the following things:
o
o
o

Users can search extensions by name or as per the functionality.
They can also install various extensions with a single click of a button.
Or users can also control all the extensions from easy-to-use location in the My Extension page.

Eneroth Tool Memory:
It is like a Cycle that like used tools with a new twist. Cycles open windows with the keys
Alt+Tab in windows, this plugin can be used to cycle recently in SketchUp. Eneroth Tool
Memory plugin can speed up highly and simplifies the modeling process; this plugin is primarily
aimed at skilled professional users who look for ways to improve their work. Moreover that,
this plugin is as most useful for tools that users use too little to have a shortcut for but vey
regular after using them.

Setup of Eneroth Tool Memory:
After installing the plugin, it will ask for some manual setup to work which cannot be done in
automated way but can be done in just few minutes:
o
o

o

Users at first need to open the Shortcut settings from the follow path: Window> Preferences>
Shortcuts.
Then users have to organize a shortcut which is Ctlr+Spacebar and follow the path: Extensions>
Eneroth Tool Memory> Cycle Tools. Users can also choose a modifier key other than Ctrl in
Windows or Command in Mac, then the following path will be: Extensions> Eneroth Tool
Memory> Set Modifier Key and select that key.
Besides the above two options, users can also set up a concur shortcut including Shift; just as
Ctrl+Shift+Space, Extensions> Eneroth Tool Memory> Cycle Tools Backwards.
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Exclude tools: The version 1.1.0 of Eneroth Tool Memory is the stratpoint of every user that can
specify tools to exclude and it can be useful when users don’t want the tool stack to get filled
with the tools which already have shortcuts. So they need to create a text file in the plugin’s
directory, and then have to write the tool names which must be similar in the tool stack and
separated by
line breaks.
Users should
keep in mind
that Certain
tools are not
added to the
tool
stack;
like
the
Texture
Positioning
Tool must be
started from
the context
menu of a
face. This tool
can
be
activated
without
a
reference to a
face but it
wouldn’t be
useful and it will not act as a tool. While Camera tools such as Orbit and Zoom Window are not
added by default as they can be added optionally though there will be risk in the stack.
It is a wonderful tool for developers as it can create and activate new tool objects than re-using
existing objects. Tools whose constructors need parameters will not be reminded by this plugin
as these tools are actually designed to be initialized in a certain way. So users make sure that
the class of their tools can be supported by Eneroth Tool Memory and initialized without
arguments.
Source: www.extensions.sketchup.com

36 | P a g e

REVIEW OF BRITISH INSTITUTE OF INTERIOR DESIGN
ACCREDITATION

The BIID CPD has approved two courses of SketchUp Hub for the interior designers which can
be applied by the SketchUp Hub users.
About SketchUp Hub: Anita Brown has established the SktchUp Hub 3D Visualization and here
are a range of courses for helping Interior Designers and students, creating exact floor plans
and elevations with a professional touch for the extreme benefit of their business or studies.
The SketchUp Hub’s total vision is to authorize Interior Designers especially women providing
right technical abilities for making exact drawings and creative illusions at professional
standards. Besides that, SketchUp Hub creates an available, engaged and fully supported
learning environment for presenting the development of STEM related skills to a female driven
industry.
In the month of January this year, the Sketchup Hub had announced their first ever 5 Day
Challenge where they had challenged designers and SketchUp users to create an awesome
kitchen design with the help of Free SketchUp download. The event was a big successful one
and many people showed their wonderful skills where the best got the winner prize and made a
place for his/her design. After that the SketchUp Hub has focused on designing the Interior
sides of houses with elevations, these elevations are actually some kind of visual tools that
allow Interior Designers to transfer perfectly their vision for a space, specifically they can work
on the design of a wall and other items within nearly view.
Confirmation on any project by highly observed and respected institution is important for any
kind of business especially one which is still trying to set up itself as an important one. That’s
why the SketchUp hub is very happy, thrilled and a little bit emotional also very proud to
announce that they have been given CPD accreditation by the British Institute of Interior Design
for two online SketchUp courses of the SketchUp Hub. The team is very proud of this important
that they are announcing the news in a magnitude way, here is a little review of this
announcement.

About British Institute of Interior Design:
The British Institute of Interior Design or BIID is the superior professional organization for
interior designers in the United Kingdom. Their growing national and international membership
represents both the commercial and residential sectors, like from heritage to cutting edge;
besides that, there are requirements which assess training, experience and professionalism.
This requirement needs the members to continue their professional development throughout
their career to ensure their continued expertise in design process, practice and regulatory
matters. The BIID is the only professional organization for interior designers which has been
given the prestigious and rare accolade of Institute status by the Minister of State.
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Mission of the British Institute of Interior Design:
The BIID is committed to encourage and support creativity and ability in the field of interior
design through assisting best practice, practical professional support, development
opportunities and education. The reason of choosing SketchUp Hub as a platform is that the
SketchUp Hub places much significance on standards and professionalism when it comes to the
making of plans and drawings using CAD software like SketchUp which can perfectly fit into the
overall of the British Institute of Interior Design and the SketchUp Hub is much honored to have
given CPD approval.

About CPD:
CPD is the abbreviation of the institute named Continuing Professional Development and it
ensures that professionals should maintain and update their skills and knowledge after
qualification. British Institute of Interior Design members must engage and record 20 hours of
CPD activities annually to continue their membership. According to a member of the BIID, a
status to CPD is a help as a form of ensure that BIID members are keeping up to date with the
latest developments is a continuously changing industry. This industry gives an opportunity to
update personal and professional skills and also a platform to engage with experts in the
industry and a forum for the exchange ideas and best practice.

There are two different forms of CPD activities:
1.

Structured and
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2. Unstructured; and all BIID members engage at least 10 hours Structured CPD activity and the
SketchUp Hub is proudly announced that their CPD activities for BIID are mentioned as for their
online nature and clear learning objectives. The BIID Knowledge Hub is an online platform that
is hosting a wide range of educational content, including the SketchUp Hub’s CPD courses.
Source: www.sketchuphub.com/british-institute-of-interior-design

MAKING A CANDLE HOLDER WITH PATTERNED PANEL AND
BENDING EXTENSION IN SKETCHUP

Alex Schreyer is a SketchUp specialist who has focused his works on wood working and some
bending objects; he created a beautiful Candle Holder to decorate home.
Decorating home is one of the most important and beautiful work as home represents our
class, passion of beauty and creates a good impression on others. But decorating home in a
right way is a difficult thing as a proper planning is needed to make a home beautiful; people
love designed or patterned things to decorate their house. Alex Schreyer has made a beautiful
candle holder by using SketchUp; the making is described here.
Alex Schreyer is Program Director and Senior Lecturer in the Building and Construction
Technology Program at the University of Massachusetts in Amherst, MA. He has been teaching
courses in Building Information Modeling and Computer-Aided Design, Building materials and
construction methods, wood properties as well as a culmination graduate structural design
class in the M.Arch. architecture program. He mainly focuses on the behavior of wood-based
structural systems with a particular interest in innovative connection systems for wooden
structures. Basically he is expert in the subjects like Teaching and Curriculum Department;
AEC/CAD and BIM Modeling and Architectural Visualization; Computational Digital Design;
Digital Fabrication, 3D Printing; Digital and Web-Based Tools in Architecture; Construction and
Planning; Building Materials and Construction Methods; North American and European
Structural Design Standards and Building Practices; Design of Wood Structures; Wood-Concrete
Composite Structural Systems; Connections in Heavy-Timber Structural Systems; Optimization
Approaches in Design; Web Development and Social-Media Outreach; Software-and ScriptDevelopment; Graphic Design.
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He is also the author of “Architectural Design with SketchUp” which provides a beginner-tointermediate-level summary of many techniques to know more about the work with the
popular
3D
modeling
application
Trimble
SketchUp. He is also the coauthor on the extensivelyused
reference
and
textbook “Fundamentals of
Residential Construction”,
which provides a total
knowledge of the materials
and method used in single
and multi-family residential
construction.
Alex uses the Patterned
panel exercise to make the
basic geometry but it can be
replaced the curved wave
pattern
with
another
beautiful pattern or can have the cutout pattern generated on colors in an image to create a
logo or landscape etc. He wanted to make a candle holder in a wonderful shape which needed
to have a curved surface which has two approaches: 1) need to make a curved surface and
placed the geometry onto it by adding and subtracting it; 2) creating the panels flat and then
curving them. To create the first surface Alex created the entire panel at first and bended it
with Thomthom’s TrueBend extension; besides it there are other extensions to do this task are
Chris Fullmer’s CLF Shape Bender, Flowify or the bending tool in the FredoScale toolset.
As this pattern consisted of repeating panels, it was very easy to break it up into quarters and
just need to combine those; after extruding the pattern the TrueBend tool is used to enter the
exact angle. Then he copied and mirrored the panel a few times and combines the whole thing
on a flat base. Here each panel was a solid and combined them using SketchUp’s Solid Tools
that made a 3D-printable solid model.
Source: www.sketchupfordesign.com/
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